Voxwire

Web Conferencing & Online Meetings

User Guide for Account Holders and Moderators

Trademarks
Product names, logos, designs, titles, words, or phrases mentioned within this publication may be trademarks,
service marks, or trade names of Voxwire Systems or other entities and may be registered in certain jurisdictions
including internationally.
Third-Party Information
Voxwire is not responsible for contents of third-party websites or resources which may be referenced in this
document. Links we provided are for your convenience. If you choose to visit them, you do this at your own risk.
Voxwire does not endorse or accept any responsibility for third-party site content.
Copyright ©2007 Voxwire Systems All rights reserved.
This manual may not be copied, photocopied, reproduced, translated, or converted to any electronic or machinereadable form in whole or in part without written approval from Voxwire Systems
Notwithstanding the foregoing, the owner or authorized user of a valid copy of the software with which this
manual was provided may print out one copy of this manual from an electronic version of this manual for the sole
purpose of such owner or authorized user learning to use such software, provided that no part of this manual may
be printed out, reproduced, distributed, resold, or transmitted for any other purposes, including, without
limitation, commercial purposes, such as selling copies of this documentation or providing paid-for support
services.

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

2 / 58

TABLE OF CONTENTS

INTRODUCTION ............................................................................................ 8
About Voxwire .......................................................................................... 8
What is an Online Meeting? ........................................................................... 8
Presenter features ..................................................................................... 9
System Requirements ............................................................................... 10
CHAPTER 1 Getting Started .......................................................................... 11
My first session ....................................................................................... 11
3 steps to presenting content on the web .................................................... 11
CHAPTER 2 Your Account Center ................................................................... 12
Setting up a session.................................................................................. 12
Quick Start ......................................................................................... 12
Schedule a Conference .......................................................................... 12
Editing a session or a recording ................................................................... 13
Editing a session .................................................................................. 13
Editing a recording ............................................................................... 13
Viewing a recording ................................................................................. 14
Viewing a recording .............................................................................. 14
Distributing a recording ............................................................................. 14
Distributing a recording ......................................................................... 14
CHAPTER 3 Inside a Conference Room ............................................................. 15
The Workspace ....................................................................................... 15
The Components ..................................................................................... 16
Meeting Roles ......................................................................................... 16
The Title Bar .......................................................................................... 17
The Menu........................................................................................... 17
Connection Status ................................................................................ 17
Using Components ................................................................................... 18
Modifying your workspace .......................................................................... 19
Preparation Mode ................................................................................. 19
Predefined Layouts ............................................................................... 20
Custom Layouts ................................................................................... 20

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

3 / 58

CHAPTER 4 The Audio / Video Component........................................................ 21
Meeting roles and component restrictions ....................................................... 21
About Audio and Video on the Internet .......................................................... 21
Bandwidth ......................................................................................... 21
Hardware........................................................................................... 21
Software ........................................................................................... 22
Firewalls ........................................................................................... 22
Voxwire System Check ........................................................................... 22
Configuring your Audio and Video ................................................................. 22
Set-up Wizard ..................................................................................... 22
Manual Configuration ............................................................................ 23
Sending Audio and Video............................................................................ 23
Starting your Broadcast .......................................................................... 23
Stopping your Broadcast ......................................................................... 24
Controlling Audio and Video Broadcasts.......................................................... 24
Pausing your Video ............................................................................... 24
Muting your Audio ................................................................................ 24
Stop receiving another user’s Video ........................................................... 24
Stop receiving another person’s Audio ........................................................ 24
Stop other users’ Broadcasts.................................................................... 24
Working with different Broadcast Modes ......................................................... 25
Switching between broadcast modes .......................................................... 25
Uploading an Image for Image Mode (Flash Player 8 or higher) ........................... 25
Setting Shape & Size ............................................................................. 25
Working with Zoom Level ....................................................................... 26
Managing User Access to the Audio / Video Component ....................................... 27
Accepting a request to speak ................................................................... 27
Denying a request to speak ..................................................................... 27
Giving users access to the Audio / Video Component ...................................... 27
CHAPTER 5 The Participant List Component ..................................................... 28
Meeting roles and component restrictions ....................................................... 28
Identifying Users ..................................................................................... 28
Changing User Names ............................................................................ 28
Identifying the number of users connected .................................................. 28
Removing a User from the Room ............................................................... 29
Changing a User’s Status ........................................................................ 29

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

4 / 58

CHAPTER 6 The Content Viewer Component ..................................................... 30
Meeting roles and component restrictions ....................................................... 30
Sharing Content ...................................................................................... 30
Taking Control .................................................................................... 30
Loading a File into the Content Viewer ....................................................... 30
Releasing Control ................................................................................. 31
Working Alone ........................................................................................ 31
Working alone ..................................................................................... 31
Follow others ...................................................................................... 31
Marking Up Content ................................................................................. 32
Showing the Whiteboard......................................................................... 32
Hiding the Whiteboard ........................................................................... 32
Using the Whiteboard ............................................................................ 32
Content Types ........................................................................................ 34
Adobe FlashPaper® ............................................................................... 34
Image Files ......................................................................................... 34
SWF ................................................................................................. 34
CHAPTER 7 The File Share Component ............................................................ 35
Meeting roles and component restrictions ....................................................... 35
Supported File Types ................................................................................ 35
Files supported by the Content Viewer ....................................................... 35
Managing files ........................................................................................ 35
Adding a file (Flash Player 8 or higher) ....................................................... 36
Canceling an upload .............................................................................. 36
Deleting a file ..................................................................................... 36
Deleting all files in a room ...................................................................... 36
Saving / downloading) a file to your computer .............................................. 37
Opening a file in the Content Viewer ......................................................... 37
CHAPTER 8 The Screen Sharing Component ...................................................... 38
Meeting roles and component restrictions ....................................................... 38
Installing the Driver ................................................................................. 38
Installing the driver with Internet Explorer® ................................................ 38
Installing the driver with Mozilla Firefox® ................................................... 39
Uninstalling the driver ........................................................................... 40
Sharing your Screen ................................................................................. 40
Starting to Screen Share ......................................................................... 40

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

5 / 58

Turning on Local Feedback...................................................................... 40
Turning off Local Feedback ..................................................................... 41
Changing your bandwidth / quality settings.................................................. 41
Stopping Screen Share ........................................................................... 41
CHAPTER 9 The URL Push Component ............................................................. 42
Meeting roles and component restrictions ....................................................... 42
Managing your URLs ................................................................................. 42
Adding a URL ...................................................................................... 42
Removing a URL ................................................................................... 42
Visiting a URL...................................................................................... 43
Pushing a URL (Co-browsing).................................................................... 43
CHAPTER 10 The Chat Component ................................................................. 44
Meeting roles and component restrictions ....................................................... 44
Working with Chat ................................................................................... 44
Typing a chat message ........................................................................... 44
Clearing the chat transcript .................................................................... 45
Saving the chat transcript ....................................................................... 45
CHAPTER 11 The POLLING COMPONENT ........................................................... 46
Meeting roles and component restrictions ....................................................... 46
Working with Polling ................................................................................ 46
Preparing a Poll ................................................................................... 46
Controlling a Live Poll ........................................................................... 47
Closing a Poll ...................................................................................... 47
Polling experience for participants and observers .......................................... 47
CHAPTER 12 Recording................................................................................ 48
Meeting roles and component restrictions ....................................................... 48
Recording your sessions ............................................................................. 48
Starting a Recording.............................................................................. 48
Stopping a Recording ............................................................................. 49
Viewing a Recording .............................................................................. 49
CHAPTER 13 Rights Management .................................................................... 50
Meeting roles and component restrictions ....................................................... 50
Working with Rights Management ................................................................. 50

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

6 / 58

Promoting or demoting a user .................................................................. 51
Changing a user’s access rights to a particular module .................................... 51
Changing a user type’s access rights to a particular module .............................. 52
Rights by User Type: Overview ................................................................. 53
INDEX ..................................................................................................... 55

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

7 / 58

INTRODUCTION

About Voxwire
Voxwire is your all-in-one web conferencing platform. Unlike other applications it is
entirely browser based and doesn’t require any installations or downloads for
participants.
Voxwire is extremely versatile. Thanks to its customizable screen layouts it is ideal
for online meetings, presentations to large audiences, training and learning. It allows
you share standard file types including the entire Microsoft Office® suite which
makes adaptation within any organization simple and rapid. Rich media applications
can be delivered thanks to Adobe Flash® and video support directly in the online
meeting room.
Setting up meetings for account holders is easy and fast, once logged in you can get
started in no more than a single click. You also have the option to schedule meetings
for the future, send out email invitations or even integrate into your existing project
management or LMS software.
Flexibility is also at the forefront of installation options. Voxwire can be accessed via
online ASP rented services or installed behind the firewall within the corporate IT
infrastructure.

What is an Online Meeting?
Online meetings are a new way to communicate using your computer. All participants
can connect to a conference call using their desktop machine, from their office, from
home, from an internet café, from the coffee shop using their laptop and a WiFi card
or from the train using UMTS mobile technology. Accessibility is always provided.
Accessing is simple. Typically a moderator will send out a normal web address, just
like a normal website. This invitation will have reached you either by email in a
formal invitation or via an instant messenger conversation. Upon clicking the link
your browser will take you straight into the meeting room. Because Voxwire is
entirely Adobe Flash® based you will not have to install or download anything to
participate, access is instant.
At the heart of every meeting is the multidirectional videoconferencing capability,
which allows you to converse with and see other participants in real time. Naturally,
participation is optional and can be limited to audio only for people who either don’t
have a camera or do not want to be seen.
But real time video conversation is only the beginning. To fully facilitate online
collaboration or training an online meeting allows you to share files, present
Microsoft PowerPoint® presentations, upload multimedia Adobe Flash® files,
communicate via text chat, collaborate via a shared whiteboard, conduct online
questionnaires and a whole lot more. The abundance of tools brings an entirely new
level of productivity to the communication experience.
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Presenter features
A wealth of features lies at your fingertips when conducting an online meeting with
Voxwire.
Real-time Videoconferencing
Connect with your audience like never before through real-time video and crystal
clear audio.
Screen Sharing
Flick a switch to show everyone in the room what’s going on on your computer. Ideal
for software training, joint web browsing and online collaboration.
Share files
Upload files to the meeting room. Other participants can download them to their PCs
from a central repository.
Record the session
Optionally a session or parts of a session can be recorded and archived. The
experience of watching an archive is the same as having been there on the day. Ideal
for asynchronous content dispersal or post-meeting review.
Get Feedback
Allow participants to text chat or even participate via the videoconferencing
modules.
Present files
Convert any file including Microsoft PowerPoint® to Adobe FlashPaper®, upload it to
Voxwire and discuss the content. Also supports standard web formats (.swf, .jpg,
.png, .gif).
Conduct questionnaires
Get feedback on the issues at hand by conducting an online live poll. Participants can
be prompted to answer multiple-choice questions, the results are presented in
standard visual graphing formats.
Push Web Pages
Proactively open websites or web content on all participants’ screens.
Control your Environment
Adapt the layout of the software to meet your particular requirements just as you
would any other software application. Everyone else is synced up automatically.
Manage Access
Allow and disallow access to all functionality for the whole group or on a user-peruser basis.
Quick Start or Schedule Meetings
Start a meeting with a single click or send out email invitations via the integrated
scheduling system.
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System Requirements
Voxwire is designed to be easily accessible from anywhere, for everyone.
Required
• A standard web browser.
• Internet connection (56K for audio, ISDN for video, DSL recommended).
• Adobe Flash® plug-in.
• For exact system requirements please refer to
http://www.voxwire.com/system_reqs.php
Optional
• A speaker system or headphones to listen to any audio broadcasts or
multimedia content.
• A headset or microphone to participate in a conference call.
• A web cam to broadcast video and videoconference.
You can visit http://manage.voxwire.com/systemcheck to check if your system
meets the requirements to participate and your firewall is appropriately
configured.
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CHAPTER 1
GETTING STARTED
This “Getting Started” guide will show you how easy it is to set up a session. It doesn’t
cover full functionality but shows you how easy it is to get started.

My first session
This guide will show you how to start a session via Quick Start, later on in the manual
we will explain how to schedule a session and invite users via email invitation.
3 steps to presenting content on the web
Two clicks and you are in!
1. Log in to your Account Center.
2. Click the “Quick Start a Session” button.
3. Congratulations! You are already in a web conference!
Now let’s invite some friends!
4. In the title bar of Voxwire, find the “Options” Menu, select “Copy Session
link to clipboard”.
5. Paste the link (CTRL-V on windows, -V on mac) into an email or your instant
messenger.
6. Sit back and wait for them to join you!
Ok, let’s give them a nice show!
7. To upload file, find the File Share component in the bottom left area of
Voxwire.
8. Click the little cogwheel icon and select “Add”. Select an image or Adobe
FlashPaper® file from your computer and wait for it to upload. Once
uploaded it will appear in the File Share component.
9. Locate the Content Viewer component and click the “Take Control” button
to start leading the session.
10. Now let’s open the file on everyone’s screen. Click the file in the File Share
component and then press the “Open” button. The file opens on everyone’s
screen.
11. Finally, click the “Start Broadcast” button at the bottom of the Audio /
Video component to start sending Audio and Video!
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CHAPTER 2
YOUR ACCOUNT CENTER
The Account Center is your main control center. It is your first stop for every session you
initiate. It allows you to start a session in 2 clicks or schedule and email invite your
conferencing partners. You also use it to edit information on meetings and manage the
recordings of your sessions.

Setting up a session
You can set up a session in 2 easy ways:
Quick Start
The fastest way to start a web conference.
1. Log in to your Account Center.
2. Click the “Quick Start a Session” button.
Congratulations! You are already in a web conference!
To invite other users find the options menu in the top left corner of Voxwire and
select “copy session link to clipboard”. Then simply paste (CTRL-V on windows,
-V on mac) the link into an email or an instant messenger conversation. You
invitees need do nothing more than click the link they received.
Any session you Quick Start is automatically given a date and time stamp and
saved in your meeting schedule for later reference together with all its files and
contents.
Schedule a Conference
Schedule a meeting for the future and send out email invitations.
1. Log in to your Account Center.
2. Click the “Schedule a session” button.
3. Fill in the form:
a. Topic - A descriptive name for the session
b. Start - Date and time of the session
c. Duration – a guideline for participants how long the meeting will
take, the room will not close after this period so there is no problem
if your meeting runs over-time.
d. Timezone (GMT) – if you are dealing with international audiences this
field allows you to specify the start time in relation to Greenwich
Meridian Time (GMT 0).
e. Pwd – If you want to protect the room with a password enter a value
here or press the “generate password” button to have Voxwire
generate one for you. Leaving the field blank will leave the room
unprotected.
f. Send Email invitation – check the checkbox if you want to send out
email invitations, 2 more fields will appear.
g. To – add all email addresses of people that you want to invite.
Separate recipients with a “,” (comma) or a “;” (semicolon).
h. Msg – Write an invitation message. This will appear in the email
invite.
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4. Check the “remember” checkbox if you want Voxwire to remember the info
you just entered. This is useful if you regularly invite the same group of
people for example.
5. Press Continue, if you decided to send email invitations they will be sent at
this stage.
Congratulations! You have scheduled a conference!
To enter the session, go to your Account Center and click the “View Schedule”
button. Find your session in the list and click on its title. Voxwire will
automatically take you to your meeting room.

Editing a session or a recording
You can edit a session’s or recording’s title, time, date, password and email
invitations.
Editing a session
1.
2.
3.
4.
5.

Log in to your Account Center.
Click the “View Schedule” button.
Click the Edit icon at the right side of every session.
Edit the details in the form.
Click Continue.

NOTE: If you have the “send email invitation” checkbox checked, emails will be
sent out.
Editing a recording
1.
2.
3.
4.
5.

Log in to your Account Center.
Click the “View Recordings” button.
Click the Edit icon at the right side of every recording.
Edit the details in the form.
Click Continue.

NOTE: Changing the password will disallow people who know the previous
password to enter.
The “Trim playback” values (start and end time) allow you to create a clipping of
the recording. Viewers will not see any part of the recording prior to the start
time or after the end time.
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Viewing a recording
If you have recorded a session or parts of a session, you can access recordings via
your Account Center.
Viewing a recording
1.
2.
3.
4.
5.

Log in to your Account Center.
Click the “View Recordings” button.
Click the name of the recording you want to watch.
The recording will load, simply click the play button.
You can fast forward or rewind by moving the play head or clicking anywhere
in the play track.
6. You can click the pause button to temporarily pause the playback at a
certain section. Click the play button to start the playback where you left
off.
7. Clicking the stop button will stop the playback and rewind the recording to
the beginning.

Distributing a recording
You can easily send the link to a recording to other people.
Distributing a recording
1. Log in to your Account Center.
2. Click the “View Recordings” button.
3. Right-Click (Mac users CTRL-click) the name of the recording you want to
watch.
4. Select “Copy Link”. The link is copied to the clipboard.
5. You can now paste the link by pressing CTRL-V ( -V on mac) on your keyboard
into an email, an instant messenger session or even onto any website.
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CHAPTER 3
INSIDE A CONFERENCE ROOM
The Workspace
When you enter a conference room you will notice a set of windows and a menu bar.
These windows are interactive units, separated by their primary function within the
meeting. We refer to these as “components”.

> A Voxwire Session

They can be moved, resized, collapsed and even hidden depending on your particular
necessities.

> Examples of alternative screen layouts
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The Components
The following components are available:
Audio / Video Component
Used for all live audio and video communication.
Userlist
See who and how many people are connected to the room.
Content Viewer
All content is shown in this window. To take control of the content viewer, click the
“Take Control” button – other users will now see what you see.
File Share
Files can be uploaded and shared with the group. If you open a file it will open in the
content viewer.
Screen Sharing
You can broadcast your screen by clicking the “Start Sharing” button at the bottom
of this window.
Chat
All users can use the text chat to communicate with you and each other, provided
they have been given access.
URL Push
Add websites to a central repository for all users to see. You can proactively open
websites on other users computers.
Live Polling
Create online questionnaires on-the-fly and make your online presentations more
interactive and engaging.

Meeting Roles
A Voxwire Conference Room is an interactive environment where everyone can
participate depending on the role they are assigned. We can distinguish between 4
roles: Account Holder, Moderator, Participant and Observer.
The person creating the room is the Account Holder. Invitees typically enter as
Observers and can be promoted to a higher user level at any time.
Each component has different right allocations per user type. These are explained in
each relevant section of the user guide. The following table illustrates some system
wide rules.

Account settings
Top-Up Credit
Promote Users to Moderator
Screen Layouts
Show / Hide Modules
Invite Users
Kick / Ban Users

Voxwire Systems

Account
Holder
9
9
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
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The Title Bar
The title bar is an integral part of every meeting. It offers access to several
important features and also gives feedback on connection status of the application
and meeting events.
The left side of the title bar is dedicated to the application menus. The right side
provides notifications on events and connection status.
menu

Event notifications

Connection status
> The title bar

The Menu
Options
> Clear Chat
> Copy access link to clipboard
> Clear ghost users
Settings
> Camera
> Microphone
> Access
Workspace
> Preparation View
> Presentation View
> Discussion View
> Screen Share View
> Custom View
> Save Current as Custom
> Show Components
Rights Management
> Selected User
> Change Status
> Moderator
> Participant
> Observer
> Audio /Video
> Chat
> Fileshare
> Participants
> Content Viewer
> Screen Share
> URL Push
> Ban Permanently
> Set Moderator Rights
> Set Participant Rights
> Set Observer Rights
Connection Status
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A green light in the top right of the Title Bar indicates you are connected to the
application.
A red light will light up if you are disconnected, accompanied by a pop-up
message. Reconnect by refreshing your browser window.

Using Components
You can hide and show components using the workspace menu in the title bar. This
can be done in two ways, either by selecting a predefined workspace layout or by
individually selecting and deselecting modules from the “show components”
submenu.

Collapse

Title bar
Context sensitive
menu

Resize Handle

> A component window

All components share some basic functionality.
•
•
•
•

They can be moved by clicking and dragging their title bar.
They can be collapsed by clicking the triangle icon on the top left of their
title bar.
They all have their individual, context sensitive menu in the cogwheel icon in
their title bar.
They can be resized by clicking and dragging their resize handle in the
bottom right of each component.

This functionality is reserved for Account Holders and Moderators only, with
exception of the context sensitive menu, which is displayed to other user types with
reduced options.
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Modifying your workspace
You can hide and show components using the workspace menu in the title bar. This
can be done in two ways, either by selecting a predefined workspace layout or by
individually selecting and deselecting modules from the “show components”
submenu.
Any changes you make to the workspace are immediately visible to all connected
users, unless you are in “Preparation Mode”, which you can turn on via the
workspace menu in the title bar.
Preparation Mode
If you move, resize or collapse windows while you are in preparation mode no
one will see what you are doing, as soon as you turn preparation off again
everyone will be synced to the layout you have just created.
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Predefined Layouts
You can easily switch between predefined layouts in the workspace menu in the
title bar. Voxwire comes with three layouts, designed for the three most common
uses: Presentation View, Discussion View and Screen Share View.
Presentation View focuses the attention of the audience on the Content Viewer
window and gives easy access to files.
Discussion View removes all elements from stage except the Audio/Video, Chat
and Participants list components. It is the perfect view for a straightforward
videoconference.
Screen Share View opens a large area for sharing your screen. The Audio/Video
module automatically switches to audio only mode to save bandwidth. This can
be overridden in the Audio/Video module.
Remember you can always add and remove components through the Workspace >
Show Components menu in the title bar.
NOTE: If the layouts differ from the ones described here your system Account
Admin has altered them to better serve your organization’s requirements.
Custom Layouts
If the predefined layouts are not enough and you frequently use a custom layout
Voxwire has an inbuilt feature which will make your life a lot easier.
1. Create the layout you prefer by dragging, resizing and collapsing the
components as you see fit.
2. In the Workspace menu, select “save current as custom”.
This layout is now saved as your custom layout. Whenever you want to return to
this layout simply select “Custom View” from the workspace menu in the title
bar.
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CHAPTER 4
THE AUDIO / VIDEO COMPONENT
The Audio / Video Component allows you to video and audio conference in real time. You
can use it to give presentations to huge audiences or to talk with colleagues in a private
environment.
The video shape & size can be configured to meet your particular bandwidth/quality
requirements and/or the amount of people that are broadcasting video at the same time.
There is also a audio/picture mode which allows speakers to upload a photo in case they
don’t have a web cam or don’t want to send video yet still create a more personal
connection to their audience.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Set Broadcast Type (Audio, Picture,
Video)
Set Video Shape & Size
Upload Image
Zoom Level
Stop Other Broadcasts
Start broadcast without permission
Start broadcast with permission
Stop your broadcast
Pause your video broadcast
Mute your audio broadcast
Pause others video
Mute others audio

Account
Holder

Moderator

9

9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

Participant

Observer

9
9

9
9

9
9
9
9
9
9

About Audio and Video on the Internet
Advances in compression technology and the increase in available bandwidth allows
the Internet to be used as a broadcast and communication medium.
To ensure the best possible quality, some factors should be considered.
Bandwidth
One basic rule applies. More bandwidth is better. However, network conditions
can vary depending on the location you log in from, the time of the day or the
audience you are addressing so it is important to be aware of this factor.
Voxwire allows you to modify your broadcast medium and adjust your video
quality settings on the fly to best meet your particular requirements and ensures
everyone has a perfect experience.
Hardware
To make sure your video and audio reach your audience at the best possible
quality the input signal first needs to be converted to a low file-size Internet
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format. Voxwire will do this for you without you even noticing but it will need
your computer to do the heavy lifting.
Video and audio encoding can be tasking process and it is important to meet the
minimum requirements to be able to ensure the best possible experience. Again,
a faster computer will allow you to send higher quality video and increase the
effectiveness of your online meetings. Similarly it is important for your audience
to have decent machines to be able to receive the video, although generally it is
not as taxing on a computer to receive (decode) the video as it is to encode it.
Of course, even the most intelligent compression algorithms cannot achieve high
fidelity image or sound if the base signal is of low quality. Make sure you buy
good quality web cams and headsets / microphones, this will have a huge impact
on the quality of your broadcasts.
Software
Voxwire relies on the ubiquitous Adobe Flash Player® as a delivery medium. This
player is constantly updated, every update brings with it huge leaps in
performance. We recommend always using the latest version for best
performance. We do realize that this is not always possible so Voxwire will also
work with older versions, starting from version 7 onwards.
Firewalls
Corporate firewalls are designed to allow only the type of information through
that your company requires. Voxwire will allow you to connect through almost
any firewall, more detailed in information for system administrators is available
here:
http://www.voxwire.com/firewallconfig.php
Voxwire System Check
An online system check is provided which tests all these requirements in an
instant. Simply point your web browser to:
http://manage.voxwire.com/systemcheck
You will get instant feedback whether your PC and Internet connection are
suitable to take part in a Voxwire web conference.

Configuring your Audio and Video
You need a microphone or headset to send audio and a web or video camera to send
video. It is essential you take some time to set-up and test your system the first time
you use it to make sure everything is configured correctly and you become
acquainted with the software. You can do this either manually or by running through
the set-up wizard.
Set-up Wizard
Go to the options > Set-up Wizard in the Title Bar menu and follow the
instructions on screen, your audio and video will automatically be configured to
best meet your system specifications.
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It is recommended to follow these instructions at least once to fully understand
the different options available. You will also be able to see and hear what you
look and sound like to other users.
Manual Configuration
In some cases you may want to change just a single setting like select a different
web cam or turn your microphone level down in a crowded room, in this case use
the manual configuration settings for quick access.
The following options are available through the “Settings” menu in the Title Bar.
Camera The Macromedia Flash Player Settings window opens. Select your
preferred camera from the dropdown menu.
NOTE: If you have the screen sharing driver installed it will appear in this list as
“DS Screen”, selecting it will broadcast your screen through the video
conferencing window. This is not recommended.
Click “Close”.
Microphone The Macromedia Flash Player Settings window opens. Select your
preferred microphone from the dropdown menu. You can reduce your broadcast
volume by moving the slider left and increase your broadcast volume by moving it
to the right. While speaking into the microphone you will see a colored bar
moving up and down. Adjust the microphone so that the bar is not constantly in
the red area.
Click “Close”.
Access The Macromedia Flash Player Settings window opens. You can allow or
deny access to your computers microphone and camera. Make sure this is set to
allow, we recommend selecting the “Remember” Checkbox.
Click “Close”.

Sending Audio and Video
Once your audio and video are properly configured you are ready to go.
Starting your Broadcast
1. Locate the Audio / Video component. By default it is in the top left
corner of the application but depending on the particular room set-up
or current view its position may have changed.
2. Click the “Start Broadcast” button.
3. Depending on your settings, the Macromedia Flash Player Settings
window may appear. Click “Allow” when asked whether access to your
microphone and camera should be allowed.
4. Your broadcast will appear in the Audio and Video component, clearly
identified with your username. All users will be able to see and hear
your broadcast exactly the same way you do.
The broadcast you send could be video, picture or audio, depending on
what has been selected and the display will vary accordingly. See the
explanation for “Broadcast Settings” below.
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Regardless of which mode is selected, you will always see a green bar
representing your microphone activity.
Stopping your Broadcast
1. Click the “Stop Broadcast” button.
2. Your broadcast will disappear from the Audio and Video component.

Controlling Audio and Video Broadcasts
Voxwire offers several additional controls over audio and video broadcasts. You can
mute your own voice and pause your video, you can choose who’s streams you want
to receive and as an Account Holder or Moderator you can turn off other people’s
broadcasts.
You may need to temporarily pause your video or mute your audio for reasons of
privacy or to save bandwidth. Similarly you may choose to stop receiving other users
video to save bandwidth or mute another users audio because their microphone is
transmitting disturbing sound. Voxwire provides a solution for all of these scenarios.
Pausing your Video
1. Click on your own video window.
2. A crossed through video camera icon will appear on top of your video,
your video is now paused and no one else will receive it.
3. Click on your video window again to resume your broadcast.
Muting your Audio
1. Click on the microphone icon in your broadcast window underneath
your username.
2. The icon will appear as crossed through, your microphone is now
muted and no one else will be able to hear you.
3. Click on your microphone icon again to resume your broadcast.
Stop receiving another user’s Video
1. Click on the user’s video window who’s video you want to pause.
2. A crossed through video camera icon will appear on top of that user’s
video. You are now no longer receiving that person’s video. This does
not influence what everyone else sees.
3. Click on their video window again to resume receiving the broadcast.
Stop receiving another person’s Audio
1. Click on the microphone icon in the broadcast window underneath the
username of the user who’s audio you want to stop receiving.
2. The icon will appear as crossed through, you are now no longer
receiving that person’s audio. This does not influence what everyone
else hears.
3. Click on their microphone icon again to resume receiving the
broadcast.
Stop other users’ Broadcasts
1. Click on the cogwheel icon in the Audio / Video component to expand
the context sensitive menu.
2. Select “Stop Other Broadcasts”.
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3. Everyone except you will be removed from the Audio / Video
component.

Working with different Broadcast Modes
To offer you full flexibility depending on any bandwidth or hardware restrictions you
may meet on a day-to-day basis depending on your particular use scenario, Voxwire
gives you several broadcast modes to choose from.
By default a room is set to video mode, but it is easy to switch to audio or image
mode.
Switching between broadcast modes
1. Click on the cogwheel icon in the Audio / Video component to expand
the context sensitive menu.
2. Select “Broadcast Type” and in the sub menu choose the mode you
want to switch to.
3. Everyone in the room will be switched to the new mode.
Video Send and receive video and audio.
Audio Send and receive only audio. This uses significantly less bandwidth and
conversation may be more responsive in low bandwidth situations.
Image Allow users to upload an image to be displayed with their audio broadcast.
This image can be either a photo or some other graphical avatar and can be used
to create a more personal connection with your audience when video is not
available either because you don’t have a web cam or want to save bandwidth.
Uploading an Image for Image Mode (Flash Player 8 or higher)
1. Click on the cogwheel icon in the Audio / Video component to expand
the context sensitive menu.
2. Select “Upload Image”.
3. A file browser window opens which allows you to select an image.
Choose any .jpg, .gif or .png file on your system. Voxwire will upload
it, resize it and display it in the Audio / Video module.
4. When you broadcast, everyone in the room will be able to see your
image. Additionally, Voxwire will save the image with your user
account, so you don’t need to upload the image every time.

Setting Shape & Size
Account holders and Moderators can change the shape and size of the
communication windows, this is most commonly used for video, but also works in
image and audio modes. The default setting is widescreen/small.
You can choose between three shapes – widescreen, portrait and landscape - in
small, medium and large sizes. Depending on your screen layout and available
bandwidth you can choose any of these settings, all users in the room will be
switched to that new format.
1. Click on the cogwheel icon in the Audio / Video component to expand
the context sensitive menu.
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2. Select “Shape & Size” and in the sub menus choose first the shape and
then the size you want to switch to.
3. Everyone in the room will be switched to the new setting.
Widescreen A cinema style 16:9 video format.
Portrait The standard newsreader or “passport photo” 8:10 format.
Landscape The standard TV 4:3 format.
Working with Zoom Level
Not to be confused with shape and size, zoom level is a local setting that allows
you to blow up another users video. This is useful when you are for example
sharing one screen with other users and bandwidth limitations do no allow you to
broadcast at a higher resolution.
Zoom multiplies the broadcast image by 2 or 3. This setting only applies to your
own computer and will not affect other users. It in no way alters the signals sent
over the network connection and has no effect on bandwidth used.
1. Click on the cogwheel icon in the Audio / Video component to expand
the context sensitive menu.
2. Select “Zoom Level” and in the sub menus choose the amount of
multiplication you would like to apply to the broadcasts.
3. The broadcast windows on your screen will be switched to the new
setting. Other users will see no change.
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Managing User Access to the Audio / Video Component
Not everyone is given the option to broadcast Audio and Video by default, different
user types have different access rights to the component.
Account Holders can broadcast at any time by clicking the start broadcast
button.
Moderators can broadcast at any time by clicking the start broadcast button.
Participants can request to speak at any time by clicking the start broadcast
button. Account Holders or Moderators have to accept their request before they
can start their broadcast.
Observers cannot see or click the start broadcast button.
Accepting a request to speak
If Participants request to speak an icon appears in the title bar. By clicking the
icon you reveal a list of users waiting for their turn. You can choose whom you
want to give access, whom you don’t and in what order.
1.
2.
3.
4.
5.

Click on the Request to Speak icon in the Voxwire Title Bar.
A list of users requesting to speak will appear.
Select a user from the lists.
Click “Accept”.
The users broadcast will appear appear in the Audio / Video
Component.

Denying a request to speak
Denying access is just as simple as accepting it.
1.
2.
3.
4.
5.

Click on the Request to Speak icon in the Voxwire Title Bar.
A list of users requesting to speak will appear.
Select a user from the lists.
Click “Deny”.
The user disappears from the list, the request is cancelled and the
request window on his or her screen disappears.

Giving users access to the Audio / Video Component
Use the Rights Management menu to turn users into Moderators or Participants to
allow them to see and use the “Start Broadcast” button. Alternatively you can
just change a particular user’s or a particular user type’s settings to allow access
to the Audio / Video Component.
Refer to the chapter on Rights Management for further instructions on how to do
this.
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CHAPTER 5
THE PARTICIPANT LIST COMPONENT
It is important you know who is taking part in the meeting, having an overview over how
many people are connected and knowing what user has what role in the meeting. These
functionalities, including the option to remove users from the meeting, are provided by the
Participant List Component.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

See who is connected
See how many people are connected
See user types
Change my name
Remove User

Account
Holder
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
9

9
9
9
9

9
9
9
9

Identifying Users
Depending on the method of invitation and your particular account settings a user
will enter with a different user type and name. The default setting for invited users
is “Observer”. The person who created the room is typically an “Account Holder”.
A user who was invited via an invitation email will typically enter identified by his
email address, this address will appear as his username in the Participant List. Users
who were invited via the “Copy Session Link to Clipboard” functionality will typically
enter as a guest and identified as such in the Participant List.
Changing User Names
To be able to better identify users, every person connected to a conference can
change their user name.
You can change your user name at any time.
1. Click on the cogwheel icon in the Participant List component to expand
the context sensitive menu.
2. Select “Change my name”.
3. A window opens prompting you to enter your name.
4. Enter the name you would like to identify you in this conference.
5. Click “Apply”.
6. The window will close and your name will change, visible to all users.

Identifying the number of users connected
The number of connected users is displayed in the bottom left of the Participant
List Module, next to a user icon. This number updates the moment someone
connects or disconnects to the room.

Voxwire Systems

Voxwire User Manual for Account Holders and Moderators

28 / 58

Removing a User from the Room
There are two ways of doing this, one is to “kick” a user out of the room, the
other is to permanently “ban” him from re-entering. The difference is that a
kicked out user can re-enter immediately whereas a banned user has to wait at
an hour before he is allowed back in.
Kick a User
1. Select him/her in the Participant List by clicking on his/her name.
2. Click the “Remove User” button in the bottom right of the Participant
List.
3. The user will disappear from the list and be disconnected from the
session.
Permanently Ban a User
1. Select him/her in the Participant List by clicking on his/her name.
2. In the Voxwire Title Bar click on the Rights Management menu, choose
“Selected User” and click on the “Ban Permanently” option.
3. The user will disappear from the list and be disconnected from the
session. He or she will not be able to re-enter for one hour.
Changing a User’s Status
If you want to change the rights of a user within the application, you do this via
the Rights Management Menu in the Voxwire Title Bar.
1. Select the user in the Participant List by clicking on his/her name.
2. In the Voxwire Title Bar click on the Rights Management menu, choose
“Selected User” and in the submenus choose “change Status” and the
User Type you want to turn that user into.
3. The user’s icon will change in the Participant List to reflect the status he
has received and his screen will update with the new options you have
assigned to him/her.
Refer to the chapter on Rights Management for more info.
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CHAPTER 6
THE CONTENT VIEWER COMPONENT
When displaying any type of document based content in Voxwire, be it video files, images,
Adobe FlashPaper® or anything else, it will be displayed in the content viewer. Typically
you will load documents in from the File Share Component which is discussed in the next
chapter.
The most important thing about the Content Viewer Component is that only one user can
lead others through the content at any one time. The component gives you feedback on
who is “leading” the presentation.
The Content Viewer also contains a multi user whiteboard which can be used to mark-up
any content.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Load content
Clear content
Show / Hide whiteboard
Take Control / Release Control
Work Alone / Follow Others

Account
Holder
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
9

9
9
9
9

9
9
9
9

Sharing Content
To be able to show content to other users you must take control of the session. While
you are leading a session everyone else can see the changes you make in the content
viewer. If you are not leading no one can see the changes you make. Please refer to
the chapter on the File Share Component on more detailed info on how to add
content to a meeting room and loading it into the Content Viewer Component.
Taking Control
Only one person can be in control of the Content Viewer Component at any one
time. Any Account Holder or Moderator can take control at any time.
1. Click on the “Take Control” button.
2. A message will appear next to the button saying “You are leading”. Any
content you load into the Content Viewer will be broadcast to other
users.
Loading a File into the Content Viewer
Files are added to the File Share Component and then loaded into the Content
Viewer Component. .swf, .jpg, .gif, .png formats are supported by the Content
Viewer Component.
1. Locate the File Share Component.
2. Select the File you want to open for the group (make sure you are
leading the session).
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3. If the file is supported by Voxwire, click the “Open” button. The button
is not visible if you cannot load the selected content into the Content
Viewer.
4. The file opens on all users’ screens.
NOTE: You can also load content into the Content Viewer Component prior to
leading a session. As soon as you click the “Take Control” button the contents of
the Content Viewer Component are propagated to all users.
Releasing Control
You can proactively release control at any time if you want to look at content
without it being propagated to all other users in the room.
1. While leading a session, click on the “Release Control” button.
2. The message “You are leading” will disappear. Any content is cleared
from the Content Viewer.

Working Alone
In some cases you may want to work alone, without having to follow along with the
presentation, for example if you need to review a document before sharing it with
the group or if you want to flick back a few slides in the currently loaded
presentation.
Working alone
Account Holders and Moderators can “break free” from following along with the
leader’s content, and as soon as they choose, can get synced up with everyone
else again.
1. Click on the “Work Alone” button.
2. The button will change to “Follow others” and you will no longer
receive updates from other users changes to the content viewer.
Follow others
At any time you can choose to follow the leader of the room again and see
exactly what everyone else is looking at.
1. While being in work alone mode, click on the “Follow Others” button.
2. The button will change to “Work Alone” and you will be synced up with
the leader of the session. If there is no leader at this point in time you
will see no change.
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Marking Up Content
Voxwire provides a multi user whiteboard directly in the Content Viewer to mark up
content, collaborate and teach.
Showing the Whiteboard
You can use it in front of a blank, white background or overlay it over any
content you have loaded into the Content Viewer component.
NOTE: While the whiteboard is visible the content in the Content Viewer is
locked. Hide the whiteboard to unlock content.
1. Click on the cogwheel icon in the Content Viewer component to expand
the context sensitive menu.
2. Select “Show/Hide Whiteboard”.
3. The Whiteboard will appear in the Content Viewer. It will always
appear above any content you may have loaded into the Content
Viewer.
Hiding the Whiteboard
The Whiteboard can be hidden at any time. Content will not be erased, if you
show it again at a later stage you will find it exactly the way you left it.
1. Click on the cogwheel icon in the Content Viewer component to expand
the context sensitive menu.
2. Select “Show/Hide Whiteboard”.
3. The Whiteboard will disappear in the Content Viewer.
Using the Whiteboard
An extensive toolset is available in the Whiteboard. Anything you write or draw
will be visible to other users as soon as you press a key or release the mouse
button. Only Account Holders and Moderators can use the Whiteboard. You can
give individual users access to the whiteboard by using the Rights Management
menu. See the chapter on Rights Management on further instructions.

Selector
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The selector tool can be used to select multiple shapes at once, by clicking on
the stage and then dragging over the shapes. If all the shapes selected are of the
same type the toolbar for that shape will be visible, so specific shape properties
such as fill, line etc can be edited at once. All these shapes can be dragged at
the same time and will be moved relatively using this tool.
Text
The text tool allows textual annotation on the board; it features customizable
text, font color and font size. To use this tool select it and drag it on the stage,
this tool has a minimum size of 40 * 22. Because the text area is selectable the
method of dragging this tool is different to other tools, it has a custom editor
with a circle handle in the middle for dragging.
Stamp
The stamp tool has a selection of shapes that are useful in diagrams, meetings
and online classes. The stamp tool has a minimum size of 16*16.
Freehand
The freehand tool enables any shape to be drawn, because of the nature of a
freehand it has no resizing capabilities, its editor draws a rectangle around the
shape to make it obvious when it’s selected.
Line
The line tool is great for flow charts or some kind of visual model for any
represented schedule or flow diagram. You can turn on an arrow at the beginning
and/or end of any line by clicking the arrow buttons in the toolbar. This shape is
completely resizable with customizable thickness and color.
Rectangle
A fundamental shape for drawing, data visualization etc, its variables include fill
color, line color and line thickness and is completely resizable.
Oval
The oval tool is another fundamental shape. It also includes fill color, line color
and line thickness as customizable properties.
Triangle
A basic shape with similar properties to rectangle and oval, fill color, line color
and line thickness however it also includes the type of triangle. It can be an
equilateral triangle or a right-angled triangle.
Eraser
You can delete individual items by pressing the delete key on your keyboard. To
quickly clear the entire whiteboard click the eraser tool.
Moving Elements
The arrow keys can be used to move shapes on the whiteboard, up, down, left
and right can be used to move one shape or a selection of shapes. By using the
shift key the shapes will move 10 pixels instead of 1 single pixel. To delete a
shape you can also use the delete key to remove a shape or a selection of shapes.
Paging
You can create and view different drawings by clicking on the left and right
arrows at the bottom left of the whiteboard. If you are on the last page, clicking
the right arrow will automatically create a new page.
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Content Types
The Content Viewer Component supports multiple file types. The most commonly
used files are Adobe FlashPaper® documents, standard image formats (.jpg, .gif,
.png) and Adobe Flash® files (.swf).
Adobe FlashPaper®
Adobe FlashPaper® allows you to create a Voxwire Voxwire compatible document
from inside application. If you are familiar with Adobe PDF writer you will
already be acquainted with this workflow. It is similar to printing a document
except that you will save a file on your PC which you can then upload to Voxwire
to be shared with a group of people. See the Adobe FlashPaper® documentation
(www.adobe.com) for full information.
Voxwire automatically detects Adobe FlashPaper® and allows you to use all its
functionality including paging, scroll, zoom and search in a multiuser
environment.
Simply load any Adobe FlashPaper® into the content viewer and you will see the
controls. If you are in control of the Content Viewer and paging, scrolling,
zooming or search activity will be propagated to all users.
This is the most common method of using Voxwire to give an online presentation.
Image Files
You can load any .jpg, .gif or .png image file that you have created in any
program into the content viewer. The image will automatically resize to fit the
height and width of the Content Viewer window.
SWF
Adobe Flash® files are one of the most commonly used formats for online
presentations, eLearning programs and animations. The support for video is
rapidly turning Adobe Flash® into the preferred method of delivering video on
the web.
You can load any Adobe Flash® file into Voxwire. It will automatically resize to
fit the height and width of the Content Viewer.
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CHAPTER 7
THE FILE SHARE COMPONENT
Any content you add to a Voxwire meeting is added to the File Share Component. You can
add any type of content to a Voxwire meeting. File types, which can be displayed directly
in a Voxwire meeting room, will be displayed in the Content Viewer Component. Any other
file type can be saved by each connected user, provided they have the appropriate
permissions.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:
Account
Holder
9
9
9
9
9
9

Add Files
Delete Files
Delete All Files
Open Files
Cancel an upload
Save Files

Moderator

Participant

9
9
9
9
9
9

9

Observer

Supported File Types
Any file can be added to the Voxwire system unless explicitly barred by the system
administrator. In most cases potentially harmful files such as .exe or .bat files will
have been restricted to avoid misuse of the application. All standard files can be
uploaded including all your Microsoft Office® files, Image Files or other industry
specific files you may need to share with the meeting participants.
Files supported by the Content Viewer
You can present Adobe FlashPaper® files, Adobe Flash® files and any web image
format (.png, .jpg, .gif) using the content viewer component. See the chapter on
the Content Viewer to find out how to load files into the content viewer.

Managing files
When a file is added to a meeting room the File Share component provides visual
feedback in the form of file type icons to facilitate its use.
Please note that uploading or downloading a file occupies your bandwidth and may
have adverse effects on any broadcasts you are sending or receiving. It is
recommended practice to upload any files prior to a broadcast.
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Adding a file (Flash Player 8 or higher)
You can add any file on you computer to the meeting room.
1. Click on the cogwheel icon in the File Share component to expand the
context sensitive menu.
2. Select “Add”.
3. A file browser opens which allows you to select a file from your
computer. Select a file by clicking on it. You can choose multiple files
by clicking CTRL or SHIFT while selecting the files.
4. Click “Select”.
5. The browser window closes and you will see a status bar in the bottom
of the File Share component. Hover over the bar to see which file is
uploading. If you have selected multiple files they will upload one after
the other.
6. Once a file has finished uploading it will appear in the File Share
component.
Canceling an upload
You can cancel any of your uploads at any time.
1. While a file is uploading click on the cogwheel icon in the File Share
component to expand the context sensitive menu.
2. Select “Cancel upload”.
3. The upload is cancelled, The file will not be uploaded to the meeting
room.
NOTE: If you are uploading several files you are provided with the options to
“Cancel this upload” or “Cancel all uploads” in Step 2. Choosing “Cancel this
upload” will cancel the file that is currently uploading and moves straight to the
next. Choosing “Cancel all uploads” will cancel all uploads.
Deleting a file
You can delete any file in the meeting room at any point in time.
1. Select the file you want to delete by clicking on it in the File Share
component.
2. Click on the cogwheel icon in the File Share component to expand the
context sensitive menu.
3. Select “Delete”.
4. An alert window opens. Click “Yes”.
5. The window closes and the file is deleted from the room.
Deleting all files in a room
You can quickly delete all files in the meeting room at any point in time.
1. Click on the cogwheel icon in the File Share component to expand the
context sensitive menu.
2. Select “Delete All”.
3. An alert window opens. Click “Yes”.
4. The window closes and all files are deleted from the room.
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Saving / downloading) a file to your computer
Any file within the meeting room can be saved to your computer.
1. Select the file you want to save by clicking on it in the File Share
component.
2. Click the “Save” button.
3. A browser window opens which allows you to choose a location on your
computer where you want to save the file.
4. Click “Save”.
5. The browser window closes.
6. A progress bar in the bottom of the File Share component gives you
feedback on the progress of the download.
7. When the download is completed the file is saved on your computer in
the location you selected.
Opening a file in the Content Viewer
If a file is supported by the Content Viewer an “Open” button appears when a
file is selected .swf, .jpg, .gif, .jpg formats are supported by the Content Viewer
Component.
1. Select the File you want to open by clicking on it.
2. Click the “Open” button. The button is not visible if you cannot load
the selected content into the Content Viewer.
3. The file opens in the Content Viewer.
NOTE: If you want other users to see this file you need to be leading the session.
See the Chapter on the Content Viewer on how to lead a session.
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CHAPTER 8
THE SCREEN SHARING COMPONENT
Next to sharing and presenting files, sharing your screen content is one of the most popular
and important forms of online information broadcast. The Screen Sharing component allows
you to send and receive your and other participants screens.
The Screen Sharing broadcast and compression codec is highly optimized to screen
broadcasts. Still, Screen Sharing is a very bandwidth intensive activity. For this reason any
Video broadcasts are automatically switched to Audio mode when any Screeen Sharing
activity is initiated.
Viewers of a Screen Sharing broadcast need no additional downloads or installations to
watch a broadcaster’s screen. Broadcasters need to install a small driver. Voxwire will
prompt you to install this driver if you attempt to share your screen and do not have it
installed.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Share your Screen
Download driver
Local Feedback on / off
Receive a Screen Share broadcast

Account
Holder
9
9
9
9

Moderator

Participant

Observer

9
9
9
9

9

9

Installing the Driver
Before you can start sharing your screen you must install the Voxwire screen sharing
driver. You need to do this only once on any computer. Once you have installed it it
will always be ready for you to use.
NOTE: Only Windows XP and Windows 2000 operating systems are supported by the
screen sharing driver. This restriction only applies to broadcasting a screen share, not
receiving.
Installing the driver with Internet Explorer®
Voxwire will recognize that you do not have the driver installed and guide you
through the installation process. This process may vary slightly depending on
which browser you are using.
1. Click the “Start Share” button.
2. An alert window will open notifying you of the missing driver and asking
you whether you want to install it.
3. Click “Yes”.
4. The File Download – Security Warning window will open asking you
whether you want to run or save this file.
5. Click “Run”.
6. An Internet Explorer – Security Warning window will open notifying you
that the publisher could not be verified and details of the file you are
about to install.
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7.
8.
9.
10.

Click “Run”.
The DS Screen Capture Driver Setup Wizard will open.
Click “Next”.
You will be prompted to select a location for the installation. The field
is prefilled. We recommend you do NOT change the default location.

c:\Program Files\Voxwire\Screen Capture
(This path may vary depending on the language of your Operating
System)
11. Click “Next”.
12. You will be prompted to select your start menu folder. The field is
prefilled. We recommend you do NOT change the default location.
Voxwire\Screen Capture
13. Click “Next”.
14. The Ready to install screen shows you where your screen sharing driver
will be installed.
15. Click “Install”.
16. The installation will run and you are presented with a screen that
confirms successful installation.
17. Click “Finish”.
18. The set up wizard will close.
19. Go back to your Voxwire window and refresh it.
You are now ready to share your screen. Click “Start share” to start sharing your
screen. Find more information below in the section Sharing your Screen.
Installing the driver with Mozilla Firefox®
Voxwire will recognize that you do not have the driver installed and guide you
through the installation process. This process may vary slightly depending on
which browser you are using.
1. Click the “Start share” button.
2. An alert window will open notifying you of the missing driver and asking
you whether you want to install it.
3. Click “Yes”.
4. A File Download window will open asking you whether you want to save
this file
5. Click “OK”.
6. The file gets downloaded to your downloads folder.
7. Locate the installer “DSScr_inst.exe” and double click it to run the
installer.
8. The DS Screen Capture Driver Setup Wizard will open.
9. Click “Next”.
10. You will be prompted to select a location for the installation. The field
is prefilled. We recommend you do NOT change the default location.
c:\Program Files\Voxwire\Screen Capture
(This path may vary depending on the language of your Operating
System)
11. Click “Next”.
12. You will be prompted to select your start menu folder. The field is
prefilled. We recommend you do NOT change the default location.
Voxwire\Screen Capture
13. Click “Next”.
14. The Ready to install screen shows you where your screen sharing driver
will be installed.
15. Click “Install”.
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16. The installation will run and you are presented with a screen that
confirms successful installation.
17. Click “Finish”.
18. The set up wizard will close.
19. Go back to your Voxwire window and refresh it.
You are now ready to share your screen. Click “Start share” to start sharing your
screen. Find more information below in the section Sharing your Screen.
Uninstalling the driver
If at any time you should choose to uninstall the Voxwire screen sharing driver
you can do so in a few easy steps.
1. Click the “Start” button in your windows operating system.
2. Navigate to All Programs > Voxwire > Screen Capture > Uninstall.
3. A window will pop up asking you whether you are sure you want to
uninstall.
4. Click “Yes”.
Depending on what applications you are running at the time you may receive a
message stating that not all elements of the application could be removed.
Assuming you haven’t changed the install location, navigate to My Computer >
Program Files > Voxwire.

Sharing your Screen
Provided you have installed the screen sharing driver, you can start broadcasting your
screen to a global audience at the click of a button.
Starting to Screen Share
Make sure the Screen Sharing component is visible on stage. If it is not, make It
visible using the Workspace menu in the title bar. More information is a available
in the section on Modifying your Workspace.
You can start screen sharing at any time, even when someone else is sharing
their screen. You will simply take over the broadcast. Only one person can
broadcast their screen at any one time.
1. Click the “Start Share” button.
2. A message appears next to the button confirming you are sharing your
screen.
3. If Video is being broadcast in the Audio / Video Component, broadcasts
will be switched to Audio to save bandwidth.
NOTE: You will not see your own screen share to save processing power. You can
however turn it on to see local feedback on what other users are seeing.
Turning on Local Feedback
This feature allows you to see your own screen sharing activity. You should not
turn this on consistently to save processing power and ultimately achieve better
performance.
1. Click on the cogwheel icon in the Screen Share component to expand
the context sensitive menu.
2. Select “Local Feedback” (only visible while sharing your screen).
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3. You will see your own screen share.
NOTE: Most likely what you will see is an repeating mirrored image of the
Voxwire interface. You are sharing your entire screen, 1024px width and 768px
height starting from the top left corner of your main screen. To show another
application or your desktop simply minimize Voxwire to the task bar or move the
window to another screen.
Turning off Local Feedback
Once you have previewed your own screen share you can turn local feedback off
again.
1. Click on the cogwheel icon in the Screen Share component to expand
the context sensitive menu.
2. Select “Local Feedback” (only visible while sharing your screen).
3. You will stop seeing your own screen share.
Changing your bandwidth / quality settings
You can adjust the quality of the image you send to other users. If you are facing
limited bandwidth you may want to adjust this setting downwards, alternatively
if you need high quality images you may want to adjust this setting upwards. As a
rule of thumb, higher quality means higher latency.
1. Click on the cogwheel icon in the Screen Share component to expand
the context sensitive menu.
2. Select “High bandwidth”, “Medium bandwidth” or “Low bandwidth”
(only visible while sharing your screen) to select the desired setting.
3. You will now share your screen at the selected quality setting.
Stopping Screen Share
When you are finished broadcasting your screen you should stop sharing and
allocate bandwidth to video and audio communications.
1. Click the “Stop Share” button.
2. The broadcast will end.
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CHAPTER 9
THE URL PUSH COMPONENT
One of the most shared resources in collaborative environments are websites or links to
resources on the web. Similar to a street address, on the web such resources are identified
by Universal Resource Locators (URL).
The URL Push Component makes it easy to create a list of such resources and even actively
“push” this content to your connected users.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Add URL
Remove URL
Push URL (co-browse)
Visit URL

Account
Holder
9
9
9
9

Moderator

Participant

9
9
9
9

9

Observer

Managing your URLs
You can create a list of URLs in either before a session or add them to the list as the
need arises. As soon as you add a URL to the list it will become visible to all users in
the session. The URLs remain in the list until you remove them, even if you leave the
room and come back later.
Adding a URL
When you enter a new conference the URL Push component will be empty. Add
URLs to the list to share them with the group.
1. Either type or copy / paste a URL into the URL Push component’s text
field.
2. Click “Add”.
3. The URL will appear in the list. All users can see it.
NOTE: URLs typically begin with “http://”. The text field is pre-filled with this
value. If you copy / paste a URL into the field make sure you do not enter that
value twice (“http://http://”) as this will make the URL incorrect.
Removing a URL
You can remove URLs from the list at any time.
1. Click on the URL you want to remove from the list.
2. In the drop down menu below the list, select “Remove” by clicking on
it.
3. Click the  button.
4. The URL will be removed from the list.
NOTE: URLs typically begin with “http://”. The text field is pre-filled with this
value. If you copy / paste a URL into the field make sure you do not enter that
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value twice (“http://http://”) as this will make the URL invalid and prohibit your
browser from finding it.
Visiting a URL
If you visit a URL a new browser window will open to view the resource. This will
only happen on your own screen.
1.
2.
3.
4.

Click on the URL you want to view from the list.
In the drop down menu below the list, select “Visit” by clicking on it.
Click the  button.
A new browser window will open, directing you to the resource.

NOTE: If you have any pop-up blockers installed they must be disabled for this
feature to work.
Pushing a URL (Co-browsing)
You can proactively open URLs on the screens of all users connected to the room.
This will open a new browser window on their screens an direct them to the
resource.
1. Click on the URL you want to push from the list.
2. In the drop down menu below the list, select “Co-browse” by clicking
on it.
3. Click the  button.
4. A new browser window will open on all users screens including your
own, directing everyone to the resource.
NOTE: Pop-up blockers installed must be disabled for this feature to work. Each
user must do this on their own computer.
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CHAPTER 10
THE CHAT COMPONENT
Chat is an unobtrusive means of communications during any online meeting or presentation.
Large or small groups of users can communicate amongst each other without interrupting
any video or audio broadcasts or causing additional bandwidth overhead.
The Chat component also doubles as a meeting transcript, automatically keeping track of
when users enter and leave the meeting and transcribing this info in chronological order.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Send Chat Messages
Save the transcript
Clear Chat Messages

Account
Holder
9
9
9

Moderator

Participant

Observer

9
9
9

9
9

9
9

Working with Chat
One of the great advantages of chat communication is its persistent nature. Messages
typed into the chat remain visible so users who join a session late or need to
temporarily divert their attention to other tasks can look back through the content to
see what they have missed. Similarly, a presenter can allow users to ask questions via
the chat component and answer them at the end of the presentation, scrolling
through the transcript at his own convenience. Another popular method is to have a
co-presenter monitor chat activity and answer questions in writing while the
presentation continues uninterrupted. Several levels of communication can co-exist
in the same Voxwire session. Finally, chat transcripts can be saved as a text file for
reference and archiving.
Typing a chat message
Chat messages can be entered at any time.
1. Type the message you want to appear into the text field at the bottom
of the Chat component.
2. Either press the Return key on your keyboard or click the  button.
3. The message will appear in the chat component, chronologically sorted
underneath the previous message.
Each user’s messages are clearly identified by his or her name and a semicolon in
front of their message.
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Clearing the chat transcript
Account Holders and Moderators can clear the chat transcript at any time. In
meetings with large user numbers and a lot of chat activity it is recommended to
do this periodically for better performance.
1. Click on the “Options” Menu, in the Voxwire Title Bar.
2. Select “Clear Transcript” from the menu.
3. The chat will be cleared.
NOTE: Once the chat transcript is cleared it cannot be recovered. Make sure you
save it if you want to store it.
Saving the chat transcript
You can save the transcript to a file on your computer at any time.
1. Click on the cogwheel icon in the Chat component to expand the
context sensitive menu.
2. Select “Save Transcript” from the menu.
3. A message appears in the chat (only visible to you) stating, “The
transcript has been saved to the following url:” followed by a link.
4. Click on the link.
5. A browser window will open containing the contents of the chat
window.
6. Save the file to a location on your computer.
7. Close the window to return to Voxwire.
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CHAPTER 11
THE POLLING COMPONENT
Polling is a welcome alternative to any online meeting or training session. It is a visual
means of allowing users to give feedback to topics and adds variety and richness to your
online conferences.
Questions are multiple choice and answers can be presented as both bar- and pie charts.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:
Account
Holder
9
9

Create Polls
Answer Questions

Moderator

Participant

Observer

9
9

9

9

Working with Polling
The account holder or a moderator generally creates polls before making them
available to all users to answer in real time. Polls can and must be created on-the-fly
at any time in a live session.
The polling module has three states.
1. Preparation, while someone is preparing a poll.
2. Live, while a poll is being conducted and users can answer questions.
3. Closed, while no-one is preparing a poll.
Preparing a Poll
If the polling module is not visible, make it visible via the workspace > Show
Components menu. If someone else is currently preparing a poll you will see a
message similar to “[Username] is preparing a poll”. You can take over control by
clicking the “end poll” button.
1.
2.
3.
4.
5.
6.
7.
8.

Click the prepare button.
Click the “add a question” ( ) button to add a question.
Enter your question in the text field that appears in the polling module.
Click the “add an answer” ( ) button to add an answer. You can add
as many answers as you like by repeatedly clicking this button.
Enter the text for each answer in the corresponding text field.
Choose a color for each answer by clicking the color selection field next
to each answer’s text field. This color will represent this question in
the results pie / bar chart when you publish your poll.
Repeat steps 2-6 for as many questions as you like. Use the red “x”
button to delete questions or answers.
Click “Go Live” to make your poll visible to everyone in the room.
Alternatively click “End Poll” if you don’t want to show your poll to
others.

You can use the blue arrows to navigate between questions. Use the drop down
menu to quickly navigate to a certain question.
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Controlling a Live Poll
Any account holder or moderator in the room can control a live poll, regardless
of whether you yourself have prepared it or not.
You can use the blue arrows to navigate between questions. Use the drop down
menu to quickly navigate to a certain question.
Any question can be displayed as a pie chart or as a bar chart. Simply click the
pie chart or bar chart buttons to switch between the views. All users will now see
the new view.
To answer a question, simply click the radio button next to the answer you want
to select. You can change the answer to a question after you have selected an
answer.
Closing a Poll
When you want to end a poll simply click the “End Poll” button. Users will no
longer be able to see the pall or answer questions.
You can also go straight back into preparation mode to edit an already created
poll by clicking the “Prepare Poll” button.
Polling experience for participants and observers
Participants and observers see a simplified view of the polling module. They do
not see the “Prepare”, “Go Live” or “End Poll” buttons. They can see a message
when nobody is preparing a poll or when a certain user is preparing a poll.
When a poll goes live they are presented with the current question title and the
possible answers. They can also see how many people responded to the question
and the percentage of people in the room who chose a particular answer to a
question. They cannot move to other questions, account holders and moderators
control the experience and pace.
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CHAPTER 12
Recording
Recording is the link between synchronous and asynchronous communication. You can use it
to create a presentation on your own and publish it on the web with very little effort or you
can record an entire online collaboration session for later reference or for transcription by
your secretary. By recording presentations no information is lost, and communications that
used to perish now become sustainable. The learning value for any organization is
immense.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types have
different access levels to this component. The following table summarizes the
differences:

Start Recording
Stop Recording
Access Recording URL
Edit Recording Information

Account
Holder
9
9
9
9

Moderator

Participant

Observer

9
9

Recording your sessions
There are some important rules to remember:
• Any Account Holder or Moderator can start a recording.
• Only one recording can be made at any one time.
• Any Account Holder or Moderator can stop the recording.
• If the person who started the recording exits the room, the recording is
stopped and archived.
When starting a recording you are prompted to enter a name. This name is similar to
the session name in that it appears in the title of the browser window when watching
a recording and is used to identify the recording in your account center. Check the
sections on Viewing and Editing Recordings for more info.
Starting a Recording
Each recording is an independent entity. Once completed a recording is
automatically archived and associated with an independent URL.
1.
2.
3.
4.
5.

Click the “Record” button in the Title Bar.
A window will appear prompting you to enter a name for the recording.
Enter a name in the text field.
Click Start.
The window closes and the recording begins.

A message in the title bar notifies you that you are recording. All connected
users can see a similar message notifiying them that you are recording the
session. All Moderators can also see a “Stop” button.
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Stopping a Recording
Account Holders and Moderators can all stop a recording.
1. Click the “Stop” button in the Title Bar.
2. The recording is stopped and archived immediately.
NOTE: If the person who started the recording leaves the session the meeting is
automatically stopped.
Pressing the record button again will start a new recording. A recording cannot
be resumed.
Viewing a Recording
Recordings are managed through the Account Center. This means only the
Account Holder can give access to the recorded sessions.
Each recording is identified by a unique URL. Account Holders can send this link
out via email, instant messenger programs or publish it on the web, thereby
giving people access from outside the Account Center.
Please refer to the appropriate section in the chapter on the Account Center for
detailed information.
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CHAPTER 13
RIGHTS MANAGEMENT
Control is everything in online meetings. Voxwire features a sophisticated user control
system second to none. 4 user types exist in session, each with a different predefined set of
access rights to each module, optimized for standard use cases.
Voxwire takes it one step further. Each user type is completely dynamic. This means you
can modify the way rights management behaves and what each user is allowed to do at any
time in real time.
You have complete control:
•
•
•
•

Promote and demote individual users to higher or lower user types.
Give an individual user particular rights to a particular component.
Configure what access rights each user type allows on a component per component
basis.
Configure what access rights user types have for the entire group.

Meeting roles and component restrictions
Each component has its own preconfigured set of rights per user type. Please refer to
the chapter of each component to understand which features are presented to each
user.
Functionality is usually hidden from users who are not allowed to use it. For
example, an observer will not see a “delete file” menu item or an “add file” button,
whereas a moderator will.
This has two advantages:
•
•

Users can be denied access to certain functionality.
Users who do not need buttons are presented with a simpler, less cluttered
interface. This makes use of the system easier and adoption faster.

Rights Management itself is also governed by access by user type.

Change particular user rights
Change user user type permissions of
all user types
Change user user type permissions of
participants and observers only

Account
Holder
9

Moderator

Participant

Observer

9

9
9

Working with Rights Management
We can distinguish between two types of interaction: Changing access rights for an
individual user or changing access rights for a group of users.
Rights management can be utilized whenever the need arises. There is no need to
decide pre-session who will be allowed to do what. Since online meetings are
dynamic environments it is important to be ready to react to any situation.
The only restriction to Rights Management is that each session can only have one
Account Holder. This is typically the user who has called the meeting.
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Promoting or demoting a user
You can choose to elevate or reduce the ability of a user to interact at any time.
1. Locate the Participant List component. If it is not visible in the
workspace, make it visible through the workspace menu.
2. Click on the user whom you want to promote or demote.
3. In the title bar, click the “Rights Management” menu.
4. Select “Selected User” > “Change Status” > The user type you want to
change a user to.
NOTE: If the “Selected User” menu is grayed out you have selected
yourself in the Participant List or not selected a user.
5. The icon of that user in the Participant List will change to represent his
new user type. Depending on how many users are connected and state
of your network connection this may take a few seconds.
6. The users interface will update in accordance to his new set of rights.
Changing a user’s access rights to a particular module
Sometimes you may want to allow a single user access to a single component
only. For example, you may want to allow a user to speak to the group but don’t
want him to be able to erase files. Voxwire makes this possible thanks to
absolute granularity of access rights management.
1. Locate the Participant List component. If it is not visible in the
workspace, make it visible through the workspace menu.
2. Click on the user whom you want to promote or demote.
3. In the title bar, click the “Rights Management” menu. Select “Selected
User”.
NOTE: If the “Selected User” menu is grayed out you have selected
yourself in the Participant Lost or not selected a user.
4. In the submenu, find the component to which you want to allow or
disallow access.
5. Another submenu opens, you can set a particular users access rights to
a higher or lower level than his current user type currently permits by
clicking that particular level.
6. Since his base user type has not changed, the user’s icon will not
change in the Participant List.
7. The users interface will update in accordance to his new set of rights.
NOTE: To check what rights a particular user has, select him in the Participant
List, click on the Rights Management menu in the Title Bar and hover over
“Selected User”. Each component has a user type icon next to it representing the
access rights to each.
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Changing a user type’s access rights to a particular module
In certain occasions you will want all of your users of a certain type to be able to
do something. Rather than having to change each user one by one you can
change the access rights set of that particular user group. An example is you
want all of the participants in the meeting to be able to upload their files to the
meeting. The Participant user type, by default, is not allowed to do this. So you
can modify this setting directly in session.
1. In the Title Bar, click the “Rights Management” menu.
2. Find the user type who’s rights you want to modify.
NOTE: The user type “Account Holder” cannot be modified.
3. Find the component who’s access rights you want to modify.
4. Select the user level you want that user type to be promoted or
demoted to.
5. All users of that user type in the session will see the changes on their
screen. New users of that user type who join session will also receive
the new modified rights scheme.
6. The users interface will update in accordance to his new set of rights.
NOTE: Moderators can only set group permissions for the user types Participant
and Observer. They cannot set group permissions for their own group.
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Rights by User Type: Overview
The following table gives a complete overview of what each user type is or isn’t
allowed to do.
Account
Holder
SYSTEM WIDE RULES
Account settings
Top-Up Credit
Promote Users to Moderator
Screen Layouts
Show / Hide Modules
Invite Users
Kick / Ban Users
AUDIO / VIDEO
Set Broadcast Type (Audio, Picture,
Video)
Set Video Shape & Size
Upload Image
Zoom Level
Stop Other Broadcasts
Start broadcast without permission
Start broadcast with permission
Stop your broadcast
Pause your video broadcast
Mute your audio broadcast
Pause others video
Mute others audio
PARTICIPANT LIST
See who is connected
See how many people are connected
See user types
Change my name
Remove User
CONTENT VIEWER
Load content
Clear content
Show / Hide whiteboard
Take Control / Release Control
Work Alone / Follow Others
FILE SHARING
Add Files
Delete Files
Delete All Files
Open Files
Cancel an upload
Save Files
SCREEN SHARING
Share your Screen
Download driver
Local Feedback on / off
Receive a Screen Share broadcast
URL PUSH
Add URL
Remove URL
Push URL (co-browse)
Visit URL
CHAT
Send Chat Messages
Save the transcript
Clear Chat Messages
POLLING
Create Polls
Answer Questions
RECORDING
Start Recording
Stop Recording
Access Recording URL
Edit Recording Information
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Moderator

Participant

Observer

9
9

9
9

9
9
9
9
9
9
9

9
9
9
9

9

9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9

9
9
9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9

9
9
9
9

9
9
9
9
9
9

9
9
9
9
9
9

9

9
9
9
9

9
9
9
9

9

9
9
9
9

9
9
9
9

9

9
9
9

9
9
9

9
9

9
9

9
9
9
9

9
9

9
9
9
9
9
9

9

9
9

9
9

9

9
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RIGHTS MANAGEMENT
Change particular user rights
Change user user type permissions of
all user types
Change user user type permissions of
participants and observers only
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9
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add file, 50
Adding a file, 36
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Adobe Flash Player®, 22
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asynchronous communication, 48
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audiences, 8, 12, 21
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41, 44
Audio / Video component, 11, 16, 21, 23,
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Audio /Video, 17
Audio and Video component, 23, 24
Audio and Video on the Internet, 21
automatically resize, 34
Ban Permanently, 17, 29
bandwidth, 20, 21, 24, 25, 26, 35, 38, 40,
41, 44
bar chart, 47
Broadcast Modes, 25
broadcast your screen, 16, 23
browser, 8, 10, 22, 25, 36, 37, 38, 39, 43,
45, 48
camera, 8, 17, 22, 23, 24
Cancel all uploads, 36
Cancel this upload, 36
Change my name, 28, 53
Change Status, 17, 51
Changing a user type’s access rights, 52
Changing a user’s access rights, 51
Changing a User’s Status, 29
Changing the password, 13
Changing User Names, 28
chat, 8, 9, 16, 17, 20, 44, 45, 53
Clear ghost users, 17
Clearing the chat transcript, 45
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Co-browse, 43
cogwheel icon, 11, 18, 25, 26, 28, 32, 36,
41, 45
collapse, 18
color, 46
communication experience, 8
component restrictions, 21, 28, 30, 35,
38, 42, 44, 46, 48, 50
components, 15
compression algorithms, 22
compression technology, 21
Configuring your Audio and Video, 22
Connect, 9
connected users, 19, 42, 48
connection status, 17, 18
Content Types, 34
Content Viewer, 11, 16, 17, 20, 30, 31,
32, 34, 35, 37
context sensitive menu, 18, 25, 26, 28,
32, 36, 41, 45
Copy Session link to clipboard, 11
Corporate firewalls, 22
crossed through, 24
custom layout, 20
Custom Layouts, 20
Custom View, 17, 20
Delete, 35, 36, 53
delete file, 50
delete key, 33
Deleting a file, 36
Deleting all files in a room, 36
delivery medium, 22
Demote, 50, 51
Denying a request to speak, 27
different user types, 21, 27, 28, 30, 35,
38, 42, 44, 46, 48
disconnected, 18, 29
Discussion View, 17, 20
Distributing a recording, 14
download, 8, 9, 37
downloading, 35, 37
downloads, 8, 38, 39
DS Screen, 23, 39
Duration, 12
edit, 12, 13
Editing a recording, 13
Editing a session, 13
email, 8, 9, 11, 12, 13, 14, 28, 49
email invitation, 11, 13
encoding, 22
Eraser, 33
Feedback, 9, 17, 22, 30, 35, 37, 38, 40,
41, 53
File Share, 11, 16, 30, 35, 36, 37
File Share component, 11
file types, 8, 34
Fileshare, 17
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firewall, 8, 10, 22
Firewalls, 22
Flash Player 8, 25, 36
Follow others, 31
Freehand, 33
functionality, 9, 11, 18, 28, 34, 50
generate password, 12
Getting Started, 11
Giving users access, 27
GMT, 12
green light, 18
Hardware, 21
headset, 10, 22
headsets, 22
hide and show components, 18, 19
Hiding the Whiteboard, 32
high fidelity image, 22
identify users, 28
image, 11, 25, 26, 34, 35, 41
Image Files, 34, 35
install, 8, 38, 39, 40
installation options, 8
installations, 8, 38
Installing the Driver, 38
instant messenger, 8, 11, 12, 14, 49
integrate, 8
Internet, 10, 21, 22, 39
Internet connection, 10, 22
Internet Explorer®, 38
invite users, 11
Invitees, 16
Kick a User, 29
landscape, 26
large, 8, 20, 21, 26, 28, 30, 35, 38, 42,
44, 45, 46, 48
layout, 9, 18, 19, 20, 26
lead others, 30
leading the session, 11
learning, 8, 48
Line, 33
link, 8, 11, 12, 14, 17, 45, 48, 49
list of users, 27
LMS software, 8
Loading a File, 30
Local Feedback, 41
Managing files, 35
Manual Configuration, 23
Marking Up Content, 32
medium, 21, 26
Meeting Roles, 16, 21, 28, 30, 35, 38, 42,
44, 46, 48, 50
meeting room, 8, 9, 13, 30, 35, 36, 37
microphone, 10, 17, 22, 23, 24
microphones, 22
Microsoft Office®, 8, 35
Microsoft PowerPoint®, 8, 9
minimum requirements, 22
missing driver, 38, 39
moderator, 8, 16, 17, 21, 24, 28, 30, 35,
38, 42, 44, 46, 48, 50, 53
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Moderators, 18, 25, 27, 31, 32, 45, 48,
49, 52
Modifying your workspace, 19
move, 18
Moving Elements, 33
Mozilla Firefox®, 39
Msg, 13
multimedia, 8, 10
multiple choice, 46
multiple-choice, 9
Mute others audio, 21, 53
Mute your audio broadcast, 21, 53
Muting your Audio, 24
network, 21, 26, 51
number of connected users, 29
Observer, 16, 17, 21, 28, 30, 35, 38, 42,
44, 46, 48, 50, 52, 53
online collaboration, 8, 9, 48
online meeting, 8, 9, 44
online meetings, 8, 22, 50
Open, 11, 31, 35, 37, 53
Opening a file, 37
Options, 11, 17, 45
or Adobe FlashPaper®, 11
ordered communication, 21, 28, 30, 35,
38, 42, 44, 46, 48
Oval, 33
paging, 34
Participant, 16, 17, 21, 28, 29, 30, 35,
38, 42, 44, 46, 48, 50, 51, 52, 53
participants, 8, 9, 12, 17, 20, 27, 35, 38,
50, 52, 54
password, 12, 13
Pause others video, 21, 53
Pause your video broadcast, 21, 53
Pausing your Video, 24
performance, 22, 41, 45
Permanently Ban a User, 29
pie chart, 47
poll, 9
Polling, 16, 46
portrait, 26
Predefined Layouts, 20
Preparation Mode, 19
Preparation View, 17
Presentation View, 17, 20
presentations, 8, 16, 21, 34, 48
presenting content, 11
Promote, 16, 50, 53
Promoting or demoting a user, 51
Pushing a URL, 43
Pwd, 12
quality, 21, 22
quality of your broadcasts., 22
questionnaires, 8, 9, 16
Quick Start, 9, 11, 12
Quick Start a Session, 11, 12
real time, 8, 21, 50
Reconnect, 18
Record, 9, 48
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recording, 13, 14, 48, 49, 53, 54
Recording your sessions, 48
Rectangle, 33
red light, 18
reduced options, 18
Releasing Control, 31
remember, 13, 48
Remember Checkbox, 23
Remove, 28, 29, 42, 53
Removing a URL, 42
Removing a User, 29
resize, 18
resize handle, 18
results, 9
Rights Management, 17, 27, 29, 32, 50,
51, 52
role, 16, 28
rules, 16, 48
Save, 17, 35, 37, 44, 45, 53
Save Current as Custom, 17
Saving the chat transcript, 45
schedule, 8, 11, 12, 33
Schedule a Conference, 12
schedule a session, 11, 12
schedule meetings, 8
scheduling, 9
Screen Capture, 39, 40
screen layouts, 8, 15
Screen Share, 17, 20, 38, 40, 41, 53
Screen Share View, 17, 20
Screen Sharing, 16, 38, 40
screen sharing driver, 23, 38, 39, 40
scrolling, 34, 44
search, 34
Selected User, 17, 29, 51
Selector, 33
Send Email invitation, 12
send out email invitations, 8, 9, 12
send video, 21, 22
Sending Audio and Video, 23
session, 9, 11, 12, 13, 14, 29, 30, 31, 37,
42, 44, 48, 49, 50, 51, 52
Set Broadcast Type, 21, 53
Set Video Shape & Size, 21, 53
Setting Shape & Size, 25
Setting up, 8, 12
Settings, 17, 23
Set-up Wizard, 22
shape & size, 21
shape and size, 25, 26
Sharing Content, 30
sharing your screen, 20, 38, 39, 40
Show Components, 17, 18, 19, 20
Showing the Whiteboard, 32
small, 25, 26, 38, 44
software, 9, 22
speaker system, 10
Stamp, 33
Start, 9, 11, 12, 16, 23, 27, 38, 39, 40,
48, 53
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Start Broadcast, 11, 23, 27
Start broadcast with permission, 21, 53
Start broadcast without permission, 21,
53
Start Share, 40
Starting a Recording, 48
Starting your Broadcast, 23
Stop, 21, 24, 25, 41, 48, 49, 53
Stop Broadcast, 24
Stop Other Broadcasts, 21, 25, 53
Stop other users’ Broadcasts, 25
Stop receiving another person’s Audio, 24
Stop receiving another user’s Video, 24
Stop Share, 41
Stop your broadcast, 21, 53
Stopping a Recording, 49
Stopping Screen Share, 41
Stopping your Broadcast, 24
Supported File Types, 35
switch between predefined layouts, 20
Switching between broadcast modes, 25
synchronous communication, 48
system administrator, 35
system administrators, 22
System Check, 22
System Requirements, 10
system specifications, 22
Take Control, 11, 16, 30, 31, 53
Taking Control, 30
test your system, 22
Text, 33
The Components, 16
The Title Bar, 17
The Workspace, 15
Timezone (GMT), 12
Title Bar, 18, 22, 23, 27, 29, 45, 48, 49,
51, 52
To, 13
toolset, 32
Topic, 12
training, 8, 9
transmitting disturbing sound, 24
Triangle, 33
triangle icon, 18
Typing a chat message, 44
UMTS, 8
Uninstalling the driver, 40
upload, 8, 9, 11, 21, 25, 34, 35, 36, 52,
53
Upload Image, 21, 25, 53
uploading, 35, 36
Uploading an Image for Image Mode, 25
URL Push, 16, 17, 42
user icon, 29
user type, 16, 27, 28, 50, 51, 52, 54
user’s icon, 29, 51
Userlist, 16
Using Components, 18
Using the Whiteboard, 32
version 7, 22
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video, 8, 9, 10, 16, 21, 22, 23, 24, 25, 26,
30, 34, 41, 44
videoconferencing, 8, 9
View Recordings, 13, 14
View Schedule, 13
Viewing a recording, 14, 49
Visit, 42, 43, 53
Visiting a URL, 43
web browsing, 9
web cam, 10, 21, 23, 25
web cams, 22
web conference, 11, 12, 22
web conferencing, 8
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web content, 9
websites, 9, 16, 42
whiteboard, 8, 30, 32, 33, 53
widescreen, 25, 26
WiFi, 8
windows, 11, 12, 15, 19, 25, 26, 40
Work Alone, 30, 31, 53
Working Alone, 31
Workspace, 17, 18, 19, 20, 51
You are leading, 30, 31
Zoom Level, 21, 26, 53
zooming, 34
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